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Introduction 
 
In this course, we go further than just an introduction to Excel. You will learn skills that are 
vital to productive with Excel. You will also learn some tips and techniques that many 
experienced Excel users lack. 
 

For this handout (in color) and more, visit my teacher’s website at: 

 www.clearcutcomputing.com/school 
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Data Managment in Excel.  
  
SORTING 
First, click somewhere within the range of data.  
Doing this will allow Excel to “stretch out” and 
detect the range of the data, which will become 
highlighted.  Now from the menu, choose: 
   DATA—SORT 
  
You can choose up to three levels of sorting.  If 
the first row in your sheet or selection contains the 
column headings, click the “Header row” button. 
  
  
AUTOFILTERS 
Autofilters allow you to quickly limit the 
display of rows of information based on 
criteria you select.  To activate the Autofilters, 
choose from the menu: 
   DATA—FILTER 
  
You will notice that pull-down arrows will 
have been added to the tops of each column.  
These arrows do not print.  To turn off the 
Autofilters, repeat the menu command again. 
  
When you click on a pull-down arrow, you 
will see a unique list of the entries in that 
column.  Simply choose one of those items in 
the list and your list will be limited to only 
those records. 
  
  
SUBTOTALS 
You can Sum, Count or Average the 
information in a column with the Subtotals 
feature.  Before you use this feature, however, 
you must SORT you data first to match the 
desired Subtotal.  Choose from the menu: 
   DATA—SUBTOTAL 
  
A window will appear from which you must 
set: 

• At each change in: 
this should be the same as the top level of 
sorting you chose (ie: City). 

• Use function: 
If you want to total up salaries or quantities, set this to “Sum.”  If you 
want to count the number of people in a town, choose “Count.” 

• Add subtotal to: 
Here you would check off the columns you want to apply the above 
function to.  You can select multiple columns. 

  
To remove the subtotals, simply repeat the menu choice and click the 
“Remove All” button from the Subtotal window. 
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Complex Spreadsheet Example 
This is part of a spreadsheet we will use in our lesson. There is a lot of variety going on here. 
 

Freeze Panes 
-the most popular choice for this is to keep the top row of a spreadsheet visible on the screen while the rest of the sheet 
can be scrolled up and down. This would be:  
Freeze Top Row. 
 
Used much less is the choice  
Freeze First Column. Now, when you scroll 
left and right, the first column stays put. 
 
But the most versatile is the first choice of the 
three, Freeze Panes, where you select a cell, 
such as D4, and choose Freeze Panes. Now, 
everything above D4 and to the left of D4 
stays put while you scroll up, down, left and 
right. 
 
 
NOTE: this does not carry through to the printing of the spreadsheet. To get the top 
row (or more) to print on the top of every page, you must go to the Page Setup dialog 
box on  the Page Layout tab, and set them in the Rows to repeat at top and  
Columns to repeat at left settings in that dialog’s Sheet tab 
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A Great Totaling Trick 
When most people total a column of numbers, they use the SUM function at the bottom of the column. This is 
cumbersome in cases where there are a lot of rows of data. Why not put the total above the column being totaled? 
 

1. Insert a row above row 1. 
2. Click where you want the answer to be -in this case, in empty cell above “Inv Amt.” 
3. Now click the AutoSum button on the Home tab. It may not be able to guess what cells you want to add up. 

Even if it does load a guess, you are going to replace that guess. 
4. Select the first few cells below Inv Amt; in this case I may have selected O3:O6. 
5. Now, since the data sheet is empty below the last row (row 93), erase the 6 and type 10000. 
6. The formula becomes =SUM(O3:O10000). Now, if you add more data below row 93, the total(s) in row 1 will 

update automatically. 
  
NOTE: I used the “s” at the end of the word total(s) to encourage you to use totals on many columns. Try a 

formula that counts the number of records in the list (suggestion: count the Last Names). 

Formulas that span multiple Worksheets or 

Workbooks 
Let’s take this further and use the steps above to put the total on 

another Worksheet. First, review the basics of the point-&-shoot 

method of building a formula. See the box to the RIGHT➔ 

 

 

Now, insert an new sheet labeled SUMMARY and follow the 

basic steps. Thanks to the Point=&-Shoot method, the 

intelligence of identifying the target worksheet, whether it be in 

the same Workbook, or another file is handled by Excel. 

REMEMBER 

To CREATE a FORMULA: 

 
1. CLICK on the cell where 

you want the answer to be. 
 

2. Press   on the keyboard 
(the equals sign). 
 

3. Build your formula. =SUM(‘Expanded DB’!O3:O10000) 
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Function Library – .Excel has over 450 Functions built-in. 
There are two ways to find them. Using the Function Library 
Window or by clicking the Formulas tab.  

The Function Library Window is the best—
especially if you don’t know exactly what function you 
are looking for. Start by clicking in the cell where you 

want the answer to be, then click the  fx  button: 

If you don’t know the name of function 
you are looking for, use the Search box 
and describe what you want. 

...Or, if you can at least narrow down the 
type of function you are looking for, select 
that type from the category pull-down,  
then scroll through the list of functions in 
that category. 

When you select the function you want to use and click OK, the Function Arguments window will appear. Fill in 
the arguments and click OK. Arguments can be cell references, constants, or a formula using either or both of 
those. Some arguments can be left blank. 
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Text Functions – There are a host of Text functions that are useful for manipulating and cleaning up data in spread-
sheets. Let’s start with a couple that are used in this sheet. 

The MID function lets you ex-
tract a portion of a text string. Its 
syntax is: 

MID(text,start_num,num_chars) 

Used in cell L3, the formula is: 

=MID(C3,1,3) & K3 

Concatenation—is when you put two or more pieces of text together. In basic 
math, we could add cells B3 + C3 if they both contained numbers. Using the 
Concatenate symbol (&) instead of the (+) produces the answer: DickClark 

The formula would look like this:  =B3&C3 

But we should have a space between the names. That is a text constant and text 
constants must be surrounded with double quotes ("). Hence we need to add to 
the middle of the equation, DoubleQuote—space—DoubleQuote  

That revised formula would be:  =B3&" "&C3 –which looks a bit odd. 

While it would work line that, we can clean it up by adding spacesbefore and 

after the & to get: =B3 & " " & C3  

The actual formula in cell J3 uses a text constant of ", " and the formula reads:  

=C3 & ", " & B3 

Other popular Text functions include: 

RIGHT(text,[num_chars])  Returns the last character or characters in a text string, based on the number of 
characters you specify. 

LEFT(text,[num_chars])  Returns the first character or characters in a text string, based on the number of 
characters you specify.  

MID(text,start_num,num_chars) Returns part of the text from the start number you provide, and for the total 
number of characters you specify. 

TRIM(text) Removes all spaces from text except for single spaces between words. Useful on 
data received from another application that may have irregular spacing. 

TEXTJOIN(delimiter, ignore_empty, text1, [text2], …)  Combines text in multiple cells separating them with a delimiter. 

 

Case Modifying functions 

LOWER(text) Converts the text to all lower case. 

UPPER(text) Converts the text to all upper case. 

PROPER(text) Converts text so the 1st letter of each word is capitalized. 
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Date Functions – Excel saves dates as a number of days since Jan 1 1900 to whatever date you typed in. 

One interesting benefit of the 
ROUNDDOWN function is that the number 
of digits can be negative. Thus the formula 
in J3 of the AgeGrp column is: 

=ROUNDDOWN((NOW()-H3)/365.25,-1) 

Excel Dates Notes 

A) Entering dates (mm/dd/yy)  

B) The “1930” threshold  

C) The NOW () function returns the current date and 
time  

D) The TODAY() function returns  just the current date  

E) Dates are stored as a serial number representing the 
number of days from January 1, 1900.  

•   1900 date system vs. 1904  

•   1900 date system is used by Excel & Lotus 1-2-3 for Windows  

•   1904 date system was used by Excel for Macintosh – All versions of 
Excel for Windows calculate dates based on the 1900 date 
system. Excel 2008 for Mac and earlier Excel for Mac versions 
calculate dates based on the 1904 date system. Excel 2016 for 
Mac and Excel for Mac 2011 use the 1900 date system, which 
guarantees date compatibility with Excel for Windows.  

    You can use the options menu to change this  

F) Date Math – to calculate an age, you might try =NOW() – date value. The 
result will be the number of days between the dates. 

G) The formula to calculate the person’s age in cell I3 is:  
=ROUNDDOWN((NOW()-H3)/365.25,0)  
--or--  
=INT((NOW()-H3)/365.25)           --uses the Integer function.  

Other popular Date functions include: 

NOW()  Returns the current date and time formatted as a date and time. 

TODAY()  Returns the current date formatted as a date. 

DAY(serial_number) Extracts the day from a date. 

MONTH(serial_number) Extracts the month number from a date. 

YEAR(serial_number) Extracts the 4-digit year from a date. 

DATE(year,month,day)  Assembles a date (as a serial number).  

WEEKDAY(serial_number,[return_type])  Returns a number representing the day of the week for the date. 
 (Incorporate the CHOOSE function to show the day name). 

EXCEL’s Popular Rounding Functions 

ROUND(number, num_digits)   
- round the number to the specified number of digits. 

ROUNDUP(number, num_digits)   
- round the number upward to the specified number of digits. 

ROUNDDOWN(number, num_digits)   
- round the number downward to the specified number of digits. 

As the formulas get more advanced, remember what you (probably) learned 
in elementary school mathematics; Order of Operations. For example the 
following could lead you to think of two possible answers: 
 

3 + 4 * 5 
 

...as written, it would equal 23. But you could force it to equal 35 by adding 
parenthesis as follows: 
 

(3 + 4) * 5 

ORDER OF OPERATIONS 

1)  ( ) parenthesis 

2)  *  / 

3)  +  - 
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Paste Operations – Excel saves dates as a number of days since Jan 1 1900 to whatever date you typed in. 

In this Invoice Aging Report-  

In order to make a useful representation of 
the last four columns, we need to bring all of 
these dates forward to a current time period. 
In short, the most recent date in the list will 
be changed to today’s date. This is only for 
the day when this class is taught. 

STEPS: 

a) We know that if we add a number to a date, we get an answer of a date that 
number of days later. Examples: 

11/8/71 + 7 = 11/15/71 (one week later) 

4/24/72 +10 = 5/4/72 (10 days later and into the next month) 

b) From the list in column “O” (Inv Date), we need to determine the oldest and 
most recent dates. The functions for that are MIN and MAX. 

c) But here’s a twist—I want to calculate those on the SUMMARY sheet. 

d) Once we find out the oldest and most recent dates, we need to calculate how 
old the most recent date is and add that number to every Inv Date. 

e) But will do that with the PASTE—ADD feature under Paste Operations. 
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The “If” Function — Easily the most popular of the conditional functions.   This function applies a test to a 
cell or formula and allows you to apply one value if the test is successful (true) or a different value if the test fails 
(false).  First, let's prepare our Mail Merge DB spreadsheet as follows: 
  

  
  
We want to test the age of each person in the list 
and if they are over the age of 59.5, we  would like to have the Age Group say “SENIOR.”  Otherwise, the 
function should place “Too young” in this column.  The syntax for the If function is as follows: 

IF(logical_test,value_if_true,value_if_false) 
  

Let’s break down what we want for each of the three parameters: 
  

 logical_value: I2 > 59.5 {is the contents of the first age column greater than 59.5?} 
 value_if_true: “SENIOR” {if yes, enter the word “SENIOR” - be sure to include the quotes} 
 value_if_false: “Too young” {if no, enter the words “Too young” - again, with the quotes} 
  

Put it all together, and you should have entered into cell J2:  =IF(I2>59.5, “SENIOR”, “Too young”) 
  
Copy the formula down into all the necessary cells below and you should see 
different results depending on the various age values.  Try changing a few of the 
birth dates to make different people older that 59.5 and the Age Group value 
should change automatically. 
  
We really don’t need to list the non-seniors as “Too young.”  Let’s make the Age 
Group cells for those people be blank.  To do this, just remove the value_if_false 
component of the function – BUT LEAVE THE COMMA.  Hence, chnge the 
formula to:  =IF(I2>59.5, “SENIOR”,) and copy it to the necessary cells below it. 
  
But this should produce zeros for the non-seniors – not exactly what we wanted.  This is because of the formatting 
of the cell to display zero values, which is the equivalent to a False result from a logical test.  To fix this, we could 
create a custom number format for these cells of a single “#” symbol.  BUT, there is an easier way to do this within 
the IF function.  Change the formula of the first cell to:  =IF(I2>59.5, “SENIOR”,””) and copy it to the necessary 
cells below it.  Notice that the value_if_false parameter is set to a pair of double quotes with no space in-between.  
This tells Excel that we want to put the NULL value in the cell. 
  
Nesting IF functions – it is possible to create many layers of IF tests in a formula.  The process is referred to as  
“nesting.” 
  

In our example above, we now want to display the word “Minor” in the Age Group for the people under 21 years 
old.  We still want our over-59.5 folks to be shown as “SENIOR” and the rest to be blank.  In words, we wish to 
perform the test: “if not a senior, test to see if a minor.”  Well, “if not a senior” the value_if_false would be 
applied.  So, in place of the double-quotes, we will insert another IF function.  Hence, the first cell should be as 
follows: 

=IF(I2>59.5, “SENIOR”, IF(I2<21, ”Minor“ ,””))  
  

Enter this formula and copy it to the necessary cells below it.  Try changing the birth dates of various people to see 
the effect of this function. 
  

This tutorial used the IF function to place text in cells.  It could also be used to conditionally place a numeric value.  
For example, if you were to insert the sales tax rate based on a State column, you could build an IF function as 
follows: =IF(F2=“NY“, 0.085, IF(F2=“CT“, 0.06 ,0)) which simply says that if the State is “NY,” put 8.5% in the 
target cell; if not, and the State is “CT,” put 6% in the target cell; otherwise use zero (the zero is unnecessary, but 
helps the “readability” of the formula). 

Enter the following formula: =(NOW()-H2)/365 
And copy it to all the cells below. 

Add this heading 

COMPARISON SIGNS 
= is equal to 
> is greater than 
< is less than 
>= is greater than or equal to 
<= is less than or equal to 
<> not equal to 
  

NOT(test)  
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PRINTING: Page Layout –set to shrink printout to one page wide by as many tall as 

Page Layout View 
Shows us how many pages, the pagination, and the header & footer. 
You can either use some buttons on the Page  Layout tab, 
Or open the Page Setup Dialog window. 

To fit on on page wide: 
Page  Layout tab –set Width to 1 page and leave Height as Automatic 
Page Setup Dialog –select “Fit to:” and 1 page(s) wide & blank pages tall. 
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PRINTING: Page Layout –Header & Footer, Print Titles 

When you click in either the header or footer area, the Header & 
Footer tab will appear. Use this to help you place Fields in these areas 

To have the top two rows print on each 
page, set the Print Titles. 
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Templates – With Microsoft Excel, you can create a spreadsheet (or workbook) that can be used as a “form” to be used 
on a regular basis. Take, for example, an Expense Report.  

We will use the PMT function (Payment). The SYNTAX of the function is: 

PMT(rate, nper, pv, [fv], [type])      the arguments, [fv] & [type] are in square brackets because they are optional. 

This is where you START; this is the Function you insert. 
After you build the formula with the FUNCTION 
HELPER, you have: 

=PMT(C7/12,C9*12,C5,C11,C13) 

This is a formula combining the two values 
above  and this answer is the pv argument. 

This is the current date; use the TODAY() 
function and format as shown. 

This is the annual rate. The rate argument must be 
a monthly rate, so the rate will be =C7/12. 

This is type argument. 

This is fv argument. 

This is the term of the loan, expressed as one normally refers 
to it –in years.. But the nper argument calls for the total 

When you’re done creating the sheet, you’re ready to save it. 

1. On the File tab, click Save As.   Unlike Save, Save As 
allows you to “translate” your spreadsheet (or workbook) 
into different formats. 

2. Then click Browse to bring up the file save dialog 
window. 

3. The Save As window at the right should appear. 

4. In the Save as type field, near the bottom, select “Excel 
Template.”  The folder in the Save in field will change to 
the Templates folder for the user’s account.  

5. Enter a File name (such as “invoice“), and click the save 
button. 

6. Finally, close your template with FileClose. 

 

Now, when you need to use the template, you must open a 
new workbook with the FileNew menu command, and 
choose the invoice template from the top of the window or 
from the templates area. 

4 

5 
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Some Useful Keyboard Shortcuts 

FORMATTING 

Cut Ctrl+X 

Copy Ctrl+C 

Paste Ctrl+V 

Open the Paste Special dialog box. Ctrl+Alt+V 

Bold text Ctrl+B 

Italic text Ctrl+I 

Underline text Ctrl+U 

Open Format Font Window Ctrl+Shift+P 

Format as currency (with red negatives) Ctrl+Shift+$ 

Format as a percent Ctrl+Shift+% 

 

INSERTING 

Insert today’s date Ctrl+; 

Invoke the SUM function Alt+= 

Insert a Function Shift+F3 

 

MOVING AROUND 

Move one cell down (unless program options changed) Enter key  

Move one cell up Shift+Enter 

Move one cell to the right Tab key 

Move one cell to the left Shift+Tab 

Go to cell A1 (or to the top left of the worksheet) Ctrl+Home 

Go to the lower right of Overall worksheet size Ctrl+End 

Move to the first column in the current row Home 

Skip over blank or filled cells  Ctrl+<arrow> 

Move one screen downward Ctrl+Page Down 

Move one screen upward Ctrl+Page Up 

 

MISCELLANEOUS 

HIDE the current ROW Ctrl+9 

HIDE the current COLUMN Ctrl+0 

SELECT the entire ROW Shift+Spacebar 

SELECT the entire COLUMN Ctrl+Spacebar 

SELECT the Entire sheet Ctrl+A 

Undo the last action Ctrl+Z 

Redo the last Undo action Ctrl+Y 

Display FORMAT CELLS Window Ctrl+1 

Print Preview Alt+Ctrl+I  or  Ctrl+P 

Save the Spreadsheet Ctrl+S 

To enter “In-Cell Editing” F2 

Find  Ctrl+F 

 


